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1. Safety and Liability

1.1. Safety and Usage Precautions
This manual contains important information regarding the safety, use and maintenance of the 
Equolink 3 software. Read the manual carefully before using the software. Keep the manual in 
a safe place for future reference.

1.2. Liability and Software License Agreement
Proceq’s “General Terms and Conditions of Sale and Delivery” apply in all cases.
All information contained in this documentation is presented in good faith and believed to be 
correct. Proceq SA makes no warranties and excludes all liability as to the completeness and/
or accuracy of the information. The subject of the license is the software that Proceq dispatch-
es to the customer by electronic means, in the version as sent and in the form as received by 
the customer. Proceq accepts no responsibility for any properties of the software, either gen-
eral or in terms of its suitability for any particular purpose. The customer carries the risk that the 
software may not meet his expectations in terms of results or performance. Proceq shall also 
not be liable for any damage suffered by the customer or third party irrespective of whether 
the damage is a direct or indirect consequence of installing or using the software or is in any 
way connected with installation or use of the software. In particular, Proceq shall not be liable 
for loss of earnings, profit or savings, or for loss of or damage to software or data. This applies 
even if Proceq is expressly made aware of such risks. Exclusion of liability applies in particular 
to all direct, indirect or consequential damage that may arise to the customer because the 
software fails to function properly or not at all for whatever reason.

1.3. Labeling
The following icon is used in conjunction with all important safety notes used in this manual.

i
Note:
This symbol indicates important information.
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2. Getting Started

2.1. Installing the Equolink 3 Software
•	 Insert the Equotip CD into the PC.
•	 Launch the “Equolink3_Setup.exe” file from the folder …\Equolink 3 PC Software\ on the 

CD.
•	 Follow the on-screen instructions.
•	 When the dialog box “Completing the Equolink 3 Setup Wizard” is displayed, select the 

check box “Launch Equolink 3” and press “Finish”.

2.2. Installing the USB Driver
The USB driver required to establish communication between the Equotip 3 and the PC via a 
USB interface is automatically installed during the Equolink 3 software installation.

2.3. Launching Equolink 3
•	 If not already launched, start Equolink 3 by clicking the icon  on the desktop, on the 

quick launch toolbar or start Equolink 3 from the Start menu.
•	 The Equolink 3 user interface will be displayed.

2.4. Establishing a Connection between the Equotip 3 and the PC
•	 Connect the Equotip 3 indicating device to the PC via USB, Ethernet cable or serial 

cable.
•	 If the Equotip 3 indicating device is not already switched on, press the on / off button 

.  
•	 Select “Equotip 3” – “Equotip 3 Explorer”. Alternatively, click on the  icon.
•	 Select the communication type, i.e. USB, Ethernet or Serial (RS 232).

2.4.1. Connecting via USB Cable
•	 The USB parameters have been defined through the driver installed with Equolink 3.
•	 After clicking “Next >”, select the desired device identified by its serial number.
•	 Once you clicked “Finish”, Equolink 3 is ready to communicate with the Equotip 3.

i
Note: Make sure Equolink 3 is installed before connecting the Equotip 3 to the 
PC for the first time. The USB driver is installed automatically with Equolink 
3. If problems occur, the driver may need to be uninstalled and Equolink 3 re-
installed; for details  refer to the “Troubleshooting” section of this manual.

2.4.2. Connecting via Ethernet Cable
•	 The device IP address must be entered. The valid IP address can be found by selecting 

“Config” – “System settings” – “IP settings...” on the Equotip 3 indicating device.
•	 After clicking “Next >”, select the desired device identified by its serial number.
•	 Once you clicked “Finish”, Equolink 3 is ready to communicate with the Equotip 3.
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2.4.3. Connecting via Serial Cable (RS 232)
•	 The COM port number for the connected device can be entered manually. Alternatively, 

use the automatic “Scan ports” option.
•	 After clicking “Next >”, select the desired device identified by its serial number.
•	 Once you clicked “Finish”, Equolink 3 is ready to communicate with the Equotip 3.

i
Note: The RS 232 interface can be used for printing and data transfer, but due 
to its speed limitations it is not suitable for device updates.

2.5. Establishing a Connection between the Equostat 3 and the PC
•	 Connect the Equostat 3 probe to the PC using the Equostat 3 probe cable.
•	 Select “Equostat 3” – “Measure”. Alternatively, click on the  icon.

3. Using the Equolink 3 Software

3.1. Application Examples
•	 Documented testing, including statistics.
•	 Professional evaluation of hardness tests, including export of data to quality management 

systems.
•	 Backup of data folders, user profiles, custom conversions.
•	 Updating Equotip 3 firmware and operating system.
•	 Equostat 3 measurements directly on a PC 

i
Note: For the Equostat 3 live testing mode, connect the Equostat 3 probe di-
rectly to the PC. 

i
Note: For automated testing and direct transfer of data between the Equotip 3 
indicating device and a quality management system, use the Equotip 3 Automa-
tion Package.
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3.2. The Equolink 3 Screen

•	 At the top of the screen, the menus are displayed along with quick launch icons.
•	 On the left-hand side of the Equolink 3 screen the folder structure of the project file (.e3p) 

is displayed. A project file can contain sub-folders and measurements downloaded from 
Equotip 3 (see section 3.3), imported from earlier Equolink 3 versions, and measurements 
made in Equostat 3 live mode. In order to see the measurement series contained in the 
project, open the respective folder.

•	 In the main window, the measurement series are displayed. The readings of each series 
can be displayed by clicking on the “show details” icon  beside the name of the mea-
surement series. The bar graphs of the readings give a clear overview, while the measured 
values, statistics and settings are displayed on the right. In order to change the settings 
(e.g. to display the results in a different hardness scale) click on the respective setting and 
choose the desired modification from the drop-down list.
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3.3. Downloading, Saving and Opening Measurement Objects

•	 Following the steps described in section 2.4, 
a dialog prompts the user to select folders 
and measurement series for download to the 
PC. The measurement series are shown in the 
currently opened project.

•	 In order to save any changes made to a 
project file press the  icon, or use the “File” 
menu.

•	 A previously saved project file can be opened 
without the Equotip 3 indicating device being 
connected. Press  and navigate to the 
respective project file (*.e3p).

i
Note: Subfolder hierarchies can be created using Equolink 3 by right-clicking 
on the folders, or on the Equotip 3 indicating device using the menu “Memory” 
– “Explorer...”.

i
Note: The user profiles file (.bin), log files (.log) and custom conversion files 
(.cnv) can be stored on the PC for backup and/or transferred to another Equotip 
3 indicating device.

i
Note: Measurements recorded with password-protected profiles can only be 
accessed after the corresponding password is entered.
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3.4. Measuring in Live Mode using the Equostat 3 Probe

•	 Following the steps described in section 2.5, a dialog appears at the bottom of the screen 
prompting the user to conduct measurements with the Equostat 3 probe. 

•	 Generated measurement objects can be saved in the currently open project by pressing 
the  icon, or via the “File” menu.

•	 To open the objects later on, press  and navigate to the respective project (*.e3p).

3.5. Editing Data
•	 If you want to change the settings of a single measurement series, open the correspond-

ing series with the “show details” button . Once opened, there are several hyperlinks 
permitting the settings to be changed. Comments can also be added.

•	 If you want to change more than one series at once, select all respective series and right 
click on the column containing the setting to be changed.

3.6. Deleting Data
•	 Highlight the series you want to delete and press the delete key on the keyboard.

i
Note: Make sure you save important measurements to a PC drive prior to de-
vice updates and prior to deleting data from the indicating device.

3.7. Exporting Data

Data can be exported by using “Edit” – “Copy” or “File” – “Export”, or by clicking on the re-
spective symbols  and :
•	 “Copy” is used to export only the selected fields of the measurement series. The data can 

then be pasted directly into an excel sheet.
•	 “Export as CSV file(s)”  opens a dialog that permits to choose the export settings. Fol-

low the on-screen instructions.
•	 “Export as graphic”  opens a dialog that permits to choose the export settings. Follow 

the on-screen instructions.

3.8. Help
The “Help” menu is used both to access help files and for updating the Equolink 3 PC software 
to the latest version that is available from the Proceq servers via the internet.

3.9. Updating the Equotip 3 Firmware and Operating System
•	 Select the “Equotip 3” menu from the menu bar and select “Upgrade Equotip 3” or click 

on the  icon.
•	 Select “Express” and confirm with “Next >”.
•	 Select the device type “Equotip 3” and confirm with “Next >”.
•	 In the “Choose Communication Type” dialog box, select the type of communication used 

between the Equotip 3 and PC, and then click “Next >”.
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•	 Make sure the serial number of the device in the drop-down list is that of the device to be 
updated; then click “Next >”.

•	 PqUpgrade will now search the Proceq servers for any available updates.
•	 Follow the on-screen instructions to finish the update.

i
Note:
Before updating the firmware, the measured data should be saved to the PC.

i
Note:
The “Custom” update is recommended for advanced users only.

i
Note:
Updating via Ethernet connection is faster than USB and Serial (RS 232).

3.10. Disconnecting the Equotip 3 from the PC

•	 Press the  icon to disconnect the Equotip 3 indicating device.
•	 Remove the cable between the Equotip 3 device and the PC.
•	 Switch off the Equotip 3 indicating device.

3.11. Disconnecting the Equostat 3 Probe from the PC
•	 Press the  icon to leave the live measurement mode.
•	 Remove the cable between the Equostat 3 probe and the PC.

3.12. Exit software
Select the “File” menu from the menu bar and select “Exit” in the submenu, or click the “Close” 
symbol in the right upper corner.
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4. Troubleshooting

4.1. Uninstalling Drivers
The Equolink 3 software and the USB driver must be installed before the Equotip 3 or the 
Equostat 3 can be connected to the PC. If the devices have been connected to the PC before 
installing the supplied USB driver, default drivers may need to be uninstalled before re-install-
ing Equolink 3:
•	 Connect the device to the PC.
•	 Open the Windows device manager.
•	 Locate the “Equotip 3 device” or the “Equostat 3 device” in the list.
•	 Uninstall the device (right-click – “uninstall device”).
•	 Disconnect the device.

4.2. Firewall Settings
•	 If no connection to the Proceq update server is established, the firewall may be blocking 

the ftp connection.
•	 Try again after disabling the firewall.

i
Note:
Do not forget to enable the firewall again after the update has been completed.

4.3. Disconnecting the Data Connection
•	 Do not disconnect the unit from the PC during data transfer. Make sure that the battery is 

sufficiently charged for the data transfer session, or use the AC power adapter.
•	 If the data transfer is interrupted, re-establish connection.

4.4. Support
Proceq is committed to providing a complete support service for Equolink 3. It is recommend-
ed that users obtain available updates and other user information regularly using Equolink 3 
and the Proceq website www.proceq.com.

4.5. System requirements
•	 A 32 bit or 64 bit version of Windows XP, Windows Vista or Windows 7
•	 A minimum  of 50 MB free disc space
•	 CD ROM drive
•	 A free USB connector / COM port / established Ethernet connection
•	 An Internet connection (for device operating system, firmware, or software updates)
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